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Lines and Angles







Introducing Points, Segments,
Rays, and Lines Name(s):
In this activity, you'll experiment with drawing, dragging, measuring,

and labeling points, segments, rays, and lines. These objects, along with
circles, are the building blocks of most geometric constructions.

Sketch and Investigate: Points and Segments

Note: If at any time you think you've made a mistake or you want to do
something differently, you can always undo as many steps as you like.
The Undo and Redo commands are in the Edit menu.

= 1. Choose the Point tool and click in the sketch

to construct a point. Click again to construct a ° @
second point. Notice that the most recently

constructed point is selected: It appears with an outline.

The Point tool

The Setlon > 2. Choose the Selection Arrow tool and click in a blank area in the

Arrow tool sketch. This deselects everything.
| > 3. Choose the Text tool. Position the finger over A B
a point, then click to display that point’s label. 4
The Text tool Display the other point’s label, too.

By default, point ) . .
labols startwih 4 | 4. With the Selection Arrow tool, click on both A B

points. Now both points should be selected. © ©
5. Inthe Measure menu, choose Distance. AB =2.72 cm
6. Drag one of the points and observe the A B_

measurement.

@1 How can you make the distance between the two points zero?

7. Choose the Segment tool and draw
a segment connecting the two points.

The Segment tool You’'ll see a triple segment at first,

indicating that the segment is selected.

8. With the segment selected, go to the
Measure menu and choose Length.

9. Use the Selection Arrow tool to drag either endpoint of the segment.
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Introducing Points, Segments, Rays, and Lines (continued)

Q2 How does the length of a segment compare to the distance between
its endpoints?

10. Use the Segment tool to construct a second
segment with one endpoint attached to the
first segment. To do this, click the mouse
button first when the pointer is in a blank D B
area of the sketch, then when it's directly
on the original segment.

11. Use the Text tool to show the labels of this segment’s endpoints.

12. Use the Selection Arrow tool to drag point D to confirm that it is
attached to AB.

13. Select CD (the segment, not its endpoints), then go to the Construct
menu and notice what choices are available. Choose Midpoint.

14, Click in a blank area to deselect C
everything. f

15. Select point D. 5

16. In the Edit menu, drag to the A
Action Buttons submenu and
choose Animation. You'll get
a dialog box you can use to
specify animation settings. To
choose the default settings, click B
OK. You've created an Animation A D
action button in your sketch.

17. Press the action button (by clicking on it) to start the animation.

18. Press the button again to stop the animation.

19. Select the midpoint; then, in the Display menu, choose Trace

Midpoint.
20. Press the Animation button again and observe the path that the
midpoint traces.
Q3 Describe the path that the midpoint traces as point D moves back
and forth.
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Introducing Points, Segments, Rays, and Lines (continued)

Sketch and Investigate: Rays and Lines

21.
22.

Stralghtedge
tocl palette

23.

24,

25.

26.

Qs

27.

In the File menu, choose New Sketch.

Press and hold down the mouse button on the Segment tool. A palette
of Straightedge tools will pop out to the right. Drag right and choose
the Ray tool.

Draw a ray in your sketch. Notice that
the ray extends in one direction beyond B
the edge of your sketch window.

Use the Text tool to show the labels of the A
ray’s control points.

Use the Selection Arrow tool to drag each
point to observe how it controls the ray.

A ray with endpoint A that passes through a point B is called ray AB
—

(represented symbolically as AB). Could it also be called ray BA?

Explain.

Select the ray and go to the Measure menu. Note that Length is
grayed out.

Why do you think you can’t measure the length of a ray?

With the ray still selected,
go to the Construct menu c
and look at your choices.
Choose Point On Ray.

Why can’t you construct
the midpoint of a ray?
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Introducing Points, Segments, Rays, and Lines (continued)

28. Drag this new point to see how its behavior compares to that of the

’ .
raxv-e buwn contral naintc

If you start or finish
drawing your
segment with the tip
of the Segment
tool directly over the
intersection of two

objects, both objects
wil highlight and
Sketchpad wil

construct an
endpoint at the

intersection.

Euclid’s Proposition 1—

An Equilateral Triangle Name(s):

Euclid, a Greek mathematician born around 300 B.C., wrote a book called
the Elements, upon which most school geometry books are still based. All
of the geometry in the Elements is built up sequentially from a few simple
constructions and postulates. Each new property that Euclid presents, or
new figure that he constructs, is based on properties he has demonstrated
previously. The construction that starts it all is the equilateral triangle.
Countless other constructions in the Elements depend on being able to
construct an equilateral triangle with compass and straightedge. In this
activity, you'll construct an equilateral triangle using only Sketchpad’s
freehand tools—the equivalents of Euclid’s compass and straightedge.

Sketch and Investigate

1. Construct AB. c

2. Construct circle AB. (Make sure "
you use point A for the center and
point B for the radius-defining

point.)

3. Construct circle BA. (Use point B
for the center and point A for the
radius point this time.)

. Construct AC and C——B, where Cisa
point of intersection of the two circles.

@1 Drag point A or point B, What happens to your triangle? Does it

appear 10 stay equilateral?

@2 Explain why this triangle is always equilateral. (Hints: What roles do
the circles play in your construction? How are they related to one
another? How are the sides of the triangle related to the circles?)

5. Hide the circles.

§

(0



Daisy Designs Name(s):

A daisy design is a simple design that you can create using only a
compass. From the basic daisy, you can create more complex designs
based on the regular hexagon.

1. Construct circle AB (a circle with
center A and radius point B).

2. Construct circle BA. Be sure you start ]
your circle with the cursor positioned 3
at point B and that you finish your circle
with the cursor positioned at point A.

It both circies are nol ’v 3. Drag point A and point B to confirm that

controlled by just . .
points A and B, undo both circles are controlled by these two points.

and try again.
4. Construct point C and point D, the two points of intersection of
these circles.

Be sure all the | 5 5
circles are
connected by

constructingthem | 6. Continue constructing circles from new intersection points to point A.
from intersections 1o

. Construct a circle from point C to point A.

existing points in the All these circles should have equal radii. The last circle you construct

it should be centered at point D. When you're done, your sketch should

exactly seven points. look like the figure below right. You should be able to drag it without
making it fall apart.

Step 5 Step 6

7. Use the Segment tool to add some lines to your design; then drag
point B and observe the way your design changes.

The six points of your daisy (besides point A) define six vertices of a
regular hexagon. You can use these points as the basis for hexagon or star
designs like those shown on the next page.

You could construct polygon interiors and experiment with color. You
could also construct arcs (select a circle and two points on it) and arc
sector and arc segment interiors (select an arc). However, you can

Exploring Gaometry with The Geometer's Skstchpad Chapter 1: Lines and Angles » 11
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Daisy Designs (continued)

probably get better results by printing out the basic line design and
adding color and shading by hand. Once you have all the lines and
polygon interiors you want, you can hide unneeded points. Don’t hide
your original two points, though, because you can use these points to
manipulate your figure.

Select three angle
measurements; then
choose Edit |
Action Button |
Hide/Show.

Angles Formed by Intersecting Lines (continued)

5. Make a Hide/Show button for three of the four angles.

6. Press the new button (in other words, click on it). It should hide the
three angle measures.

Q4 Drag a point so that the one visible angle measure is 63°. Find the
measures of the other three angles without looking. Write your guess
below, then press the button to check your guess.

7. Test yourself a few more times for practice: Hide the angle measures,
drag to change the angles, guess at the hidden angle measures, then
check your guess.

Explore More

1. Suppose you had three lines intersecting in a single point to form
six angles.

a. How many angle measures would you need to know in order
to find the other angle measures?

b. Describe any situations in which all the angles are congruent.

2. Suppose you have four lines intersecting in a single point to form
eight angles. Answer parts a and b from Explore More 1, above, for

this different case.

3. Now generalize your results from the last two questions. Suppose you
had 7 lines intersecting to form 2n angles. Answer parts a and b from
Explore More 1, above, for this general case.

N

[



Properties of Parallel Lines Name(s):

In this investigation, you'll discover relationships among the angles
formed when parallel lines are intersected by a third line, called a
transversal.

Sketch and Investigate

1. Construct AB and point C, not on AB.

Select the line and 2
the point; then,
in the Construct

menu, choose | 3 Construct CA. Drag points C and A to make sure the three lines are

Parallel Line.

. Construct a line parallel to AB through point C.

attached at those points.
o C < C/
Using the Text icol, Step 1 Steps 2 and 3
click once on a point
to show its label. ,
Doublo-ciick the > 4. Construct points D, E, F, G, and
labe} to change . H as shown at right.
. . F
angfe": oo > 5. Measure the eight angles in your
points, with the figure. Be systematic about your G

vertex your middle . , o, O >

selection. Then, in measuring to be sure you don’t D E

e e, measure the same angle twice.

6. Drag point A or B and see < 3 A B >

which angles stay congruent.
Also drag the transversal EA. H
(Be careful not to change the
point order on your lines. That
would change some angles into Step 4
other angles.) Observe how many
of the eight angles you measured appear to be always congruent.

Q1 When two parallel lines are crossed by a transversal, the pairs of
angles formed have specific names and properties. The chart on the
next page shows one example of each type of angle pair. Fill in
the chart with a second angle pair of each type, then state what
relationship, if any, you observe between the angles in a pair type.

Exploring Geometry with The Geometer's Sketchpad Chapter 1: Lines and Angles = 17
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Properties of Parallel Lines (continued)

Angle Type Pair 1 Pair 2 Relationship

Corresponding ZFCE and ZCAB

Alternate interior ZECA and LCAG
Alternate exterior ZFCE and £LHAG
Same-side interior ZECA and ZBAC
Same-side exterior | ZFCD and ZHAG

@2 One of the angle types has more than one pair. Name that angle type
in the chart below, and name the third and fourth pairs of angles of
that type.

Angle Type Pair 3 Pair 4 Relationship

7. Next, you'll investigate the converses of
your conjectures. In a new sketch, draw E
two lines that are not quite parallel.
Construct a transversal.

8. Add points as needed, then measure all
eight angles formed by the three lines.

9. Move the lines until you have two sets
of four congruent angles.

Q3 If two lines are crossed by a transversal
so that corresponding angles, alternate
interior angles, and alternate exterior
angles are congruent, what can you say about the lines?

Explore More

1. You can use the converse of the parallel-

lines conjecture to construct parallel lines.
€3

Construct a pair of intersecting lines AB and
AC as shown. Select, in order, points C, A,
and B. Then, in the Transform menu, choose N
Mark Angle. Double-click point C to mark /ﬂ B
it as a center for rotation. You figure out the
rest. Explain why this method works.

18 » Chapter 1: Lines and Angles ’ Exploring Geometry with The Geometer's Sketchpad
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Constructing a Perpendicular Bisector Name(s):

In this activity, you'll use only Sketchpad'’s freehand tools to construct
perpendicular bisectors. Then you'll investigate properties of
perpendicular bisectors. In Explore More, you'll devise a shortcut for
constructing a perpendicular bisector using Sketchpad’s Construct menu.

1. Construct AB.

2. Construct circle AB. (Make sure you use
point A for the center and point B for the
radius endpoint.)

3. Construct circle BA. (Use point B for the
center and point A for the radius point.)

Press and hold down

the mouse button > 4. Construct ffD, where C and D are the
Straigntodes oot circles’ points of intersection.
then drag to choose . .
the Line tool. | 5. Drag points A and B to make sure your construction stays together.

@1 Line CD is the perpendicular bisector of AB, Without measuring,
what can you say about the distances AC and BC and the distances
AD and BD?

6. Construct E, the point of intersection of AB and ED.

Q2 What's special about point E? Move points A and B to confirm
your answer.

7. Hide the circles.
8. Construct a point F on éD.

To measure a .
distance, Selodt two 9. Measure the distances FA and FB.

points; then, in the . .
Measure menu, | @3 Drag point I up and down the line. Make a

choose Distance. . . ;
conjecture about any point on a segment’s
perpendicular bisector.

Explore More

Fa"r:;'ﬁ:igg makind 1> 1. In a new sketch, construct a segment. Figure out how to construct the

yiools, choosa perpendicular bisector of the segment using the Construct menu.
the Help menu, When you've succeeded, make a custom tool and save it in the Tool
chen click on the Folder (next to the application itself on your hard drive). Write a
description of the way you did the construction.
Exploring Geometry with The Geometer's Sketchpad Chapter 1: Lines and Angles « 19
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The Clawae of o1
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It's easier to draw a
horizontal or vertical
line if you hold
down the Shift key
while you draw.

Line Whdth is in the
Display menu.

Select CDand

noints Eand F; then,

in the Construct

menu, choose
Paraliel Lines.
You should get
both parallel lines
at once.

Drawing a Box with
Name(s):

Two-Point Perspective

Even though a piece of paper or a computer screen is flat, you can draw
figures that appear three-dimensional on these two-dimensional surfaces
by using perspective drawing. In three dimensions, objects that are farther
away appear smaller. Perspective drawing takes advantage of this
principle to make flat drawings appear to have depth.

Follow these steps to draw a box with two-point perspective. Labels are
shown to clarify these directions, but you probably won't want labels on
your drawing.

~ 1. Draw a long horizontal line segment AB. This will be your horizon line,
and its endpoints will be the vanishing points of your perspective box.

— 2. Draw a short vertical segment CD below your horizon line. This will
be the front edge of your box. Change its line width to dashed.

3. Construct CA, DA, CB, and DB.

-
-
-

- -

-~ -~

C‘-
:
|
ﬁt
D

4. Construct point E on DA and point F on DB.

3. Through points £ and £, construct lines parallel t CD.

6. Construct GB and HA, where points G and H are the points where the

parallel lines intersect CA and CB.

7. Construct point I at the point of intersection of GB and HA.
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Drawing a Box with Two-Point Perspective (continued)

8. Change the line width of CD to thick, then complete the box

by constructing GI, IH, HF, FD, DE, EG, GC, and CH.

|
'
1
I

A4 N

9. Hide all the dashed lines and segments to leave just your box and the
horizon line.

Ao c B

10. Try moving various parts of your box, your horizon segment, and the
vanishing points. If you move the front edge of your box above the
horizon segment, you'll discover that you haven't created the bottom
of your box. Continue sketching to construct the missing edges as
shown. (Hint: Start by constructing a dashed segment from point E
to point B.)

11. Hide unwanted points and segments.
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